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Лабораторная работа № 7 

 
ЦЕЛИ РАБОТЫ: 
 
 1) изучение системы инструментальных средств электроники Electronics 
Workbench, 
2) исследование цифровых устройств на данном пакете, 
3) приобретение навыков работы с системой перевода STYLUS на стадии 
выполнения п.1. 
 

1. Краткие сведения по системе перевода языков STYLUS. 
    В системе STYLUS  можно переводить тексты, которые находятся в файлах, 
или же набирать текст непосредственно в STYLUS и тут же его переводить. 
    Файл с текстом перевода может быть подготовлен в следующих форматах: 
только текст (*.txt), MS-DOS текст (*.txt), Word for Windows 6.0, 7.0 (*.doc), 
Word for MS-DOS 3.x-5.x (*.doc), форматированный текст (*.rtf), Windows Write 
3.X(*.wri), файлы гипертекста HTML. 
    Ограничимся режимом перевода справки (HELP) системы  Electronics 
Workbench. Для этого: 
          1) запускаем STYLUS; 
          2) в меню «Файл» выбираем команду «Открыть»; 
          3) вменю «Перевод» выбираем, например, команду «Перевод всего 
документа», «английский-русский»; 
          4) кнопкой свёртывания (с изображением знака подчёркивания) в верхнем 
правом углу окна сворачиваем окно; 
          5) запускаем Electronics Workbench; 
          6) вызываем справку (HELP); 
          7) раскрываем нужный раздел справки; 
          8) выделяем текст; 
          9) копируем текст в буфер (ctrl-C); 
         10) щёлкаем с помощью мыши по значку StylusLauncher внизу на панели 
задач; 
         11) вставляем выделенный текст из буфера (ctrl-V). 

    На экране в процессе перевода будет выводиться окно с информацией о 
проценте переведённого текста. После выполнения перевода окно документа 
делится на два подокна: в верхнем выводится исходный текст, в нижнем – 
его перевод. Слова, не найденные в подключенных словарях, выводятся в 
тексте документа красным цветом, а зарезервированные слова – зелёным. 
Для того чтобы некоторые слова не переводились и оставались в тексте 
перевода так, как они встречаются в исходном тексте( например, Windows), 
их нужно зарезервировать. 
    Весь список незнакомых слов можно увидеть внизу на вкладке 
«незнакомые слова». 
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    Если в окне документа не видны метки абзацев и не выводятся красным 
цветом незнакомые слова, то выберите в меню «Сервис» команду 
«Параметры», вкладку «Цвета» и установите опции «Использовать условные 
значки» и «Использовать цветовую подсветку». 
    Возможны другие режимы перевода, с которыми можно ознакомиться в 
справке STYLUS. Далее: 

         12) помещаем курсор в верхнее окно в конце текста, нажимаем, например 
     два раза на клавиатуре «Ввод» для резервирования пустых строк; 
         13) сворачиваем окно STYLUS; 
         14) на панели задач нажимаем кнопку справки Electronics Workbench; 
         15) открываем следующий раздел справки; 
         16) повторяем с п.8. 

 
2. Краткие сведения по системе Electronics Workbench 

 
    Представление о возможностях системы и методах исследования 
электронных схем можно получить из оглавления «Справки» и ее разделов. 
Учитывая неточность перевода системой STYLUS, а также использование 
ограниченного числа разделов Electronics Workbench при выполнении 
данной лабораторной работы, разделы справки приведены ниже на 
английском языке. 

 
Help Table of Contents 

 
Choose a topic for information 

 
Using Help 
Using the mouse and keyboard 
Parts of the workbench 
Building and testing a circuit 
Components 
Instruments 
Menu reference 
User support 
Index 
 
 To close this window, double-click the Control-menu box in its top left corner. 
 
Using Help 
 
The Electronics Workbench Help system, like a book, has a Table of Contents, an 
Index and a sequence of screens. You can use these book-like features to find 
information, plus you can use "hypertext" features to get related information, search 
for topics or retrace your steps. 
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 To see more information, drag the scroll box. 
 
 To browse, click the >> and << buttons. 
 
 To learn more about an underlined topic, click it. 
 
 To retrace your steps, click Back or History. 
 
 To go to the Table of Contents, click Contents. 
 
 To get a listing of the main Help topics, choose Index from the Table of Contents or 
from the Help menu. 
 
 For specific information on a component or instrument, select it before choosing 
Help from the Help menu. 
 
 If you want to see the Help window while you work, turn on Always On Top in the 
Help window's Help menu. 
 
For more information on using Help, press F1. 
 
Using the mouse and keyboard 
 
You build and test circuits using the mouse. You can: 
 
 Drag components and instruments about the display. 
 
 Select or choose components, buttons and other objects by pointing and clicking. 
 
 Select more than one object at a time. 
 
 Take shortcuts by double-clicking. 
 
You need to use the keyboard only for occasional text entry or keyboard shortcuts. 
 
See also: About the mouse buttons 
 
Parts of the workbench 
 
Electronics Workbench is much like a real electronics workbench. Everything you 
need to build and test circuits is organized neatly in front of you or is readily at hand. 
 
The large central area is the workspace where you build and test a circuit. 
 
Beside the workspace is a parts bin. 
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At the top of the display you'll find menus, test instrument icons and the power 
switch for activating the circuit. 
 
Building and testing a circuit 
 
 To build and test a circuit: 
 1. Drag components from the parts bin. 
 
2. Place them on the workspace. 
 
3. Wire the components together. 
 
4. Set component values or models. 
 
5. Attach test instruments. 
 
6. Activate the circuit. 
 
Note: To help you get going, there are sample circuits available for you to look at, 
tinker with and borrow from. 
 
Components 
 
Choose a component for information. 
 
555 timer 
AC current source 
AC voltage source 
Adder 
Analog-to-digital converter 
AND gate 
Ammeter 
BJTs 
Battery 
BCD-to-seven-segment decoder 
Buffer 
Bulb 
Buzzer 
Capacitor 
Clock 
Connector 
Controlled sources 
Counter 
D flip-flop 
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DC battery 
DC current source 
Decoded seven-segment display 
Decoder 
Demultiplexer 
Diac 
Digital-to-analog converter 
Diode 
Encoder 
Flip-flops 
Full-adder 
Full-wave bridge rectifier 
Fuse 
Gates 
Ground 
Half-adder 
IC 
Inductor 
 
JFETs 
JK flip-flop 
LED 
Monostable multivibrator 
MOSFETs 
Multiplexer 
Multiplier 
NAND gate 
NOR gate 
NOT gate 
OR gate 
Opamp 
Output table 
Potentiometer 
Probe 
Pull-up resistor 
RS flip-flop 
Relay 
Resistor 
Resistor Pack 
Silicon-controlled rectifier 
Seven-segment display 
Shift register 
Shockley diode 
Switches 
Transformer 
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Transistor 
Triac 
Tristate buffer 
Variable capacitor 
Variable inductor 
Variable resistor 
Voltmeter 
XOR gate 
XNOR gate 
Zener diode 
 
Instruments 
 
Seven test instruments are stored above the workspace: 
 
Multimeter 
Function generator 
Oscilloscope 
Bode plotter 
Word generator 
Logic analyzer 
Logic converter 
 
There are also two meters in the parts bin: 
 
Voltmeter 
Ammeter 
 
See also: Using instruments 
 
Using menus 
 
You can choose commands from these Electronics Workbench menus: 
 
File 
Edit 
Circuit 
Window 
Help 
 
There are two ways to choose a command from a menu: 
 
1. Click a menu title so it stays open. Then click the command you want; or 
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2. Press ALT followed by the underlined letter in the menu you want to open. (For 
example, to open the File menu, press ALT, then press F.) Next, press the underlined 
letter in the command you want to choose. 
 
A command that is gray or "dimmed" cannot be chosen at the moment. For example, 
if no component is selected, commands such as Label or Rotate that act on 
components are dimmed and cannot be chosen. 
 
See also: Keyboard shortcuts 
 
User Support 
 
We hope you enjoy using Electronics Workbench. To help you get the most out of 
the software, we offer a number of support products for registered users. For 
information about these products, or to pass on your comments and questions, contact 
us by phone, fax, email, bulletin board service (BBS) or mail. (If you are outside 
North America, please contact your dealer.) 
 
Phone 
Fax 
Email 
BBS 
Mail 
 
Please use your Electronics Workbench serial number whenever you contact us. 
You'll find it on the back of the User's Guide. Or, choose About Electronics 
Workbench from the Help menu. 
 
Help Index 
 
Choose an entry for information. 
 
555 timer 
AC current source 
AC voltage source 
Activate command 
Activating a circuit 
Adder 
Ammeter 
Analog-to-digital converter 
Analysis Options command 
AND gate 
ANSI symbols 
Arrange command 
Assume linear operation 
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Battery 
BCD-to-seven-segment decoder 
BJTs 
Bode plotter 
Bulb 
Buffer 
Buzzer 
Capacitor 
Capturing a circuit 
Circuit, building and testing 
Circuit menu 
Circuit simulation 
Circuits, samples of 
Clipboard 
Component symbols, ANSI or DIN 
Components, list of 
Connector 
 
Controlled sources 
Copy command 
Counter 
Current-controlled current source 
Current-controlled switch 
Current-controlled voltage source 
Customizing 
Cut command 
D flip-flop 
DC battery 
DC current source 
Decoded seven-segment display 
Decoder 
Delete command 
Demultiplexer 
Depletion MOSFETs 
Description command 
Diac 
Digital-to-analog converter 
DIN symbols 
Diode 
Dragging 
Edit menu 
Encoder 
Enhancement MOSFETs 
Error messages 
Exiting 
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File menu 
Flip-flops 
Full-adder 
Full-wave bridge rectifier 
Function generator 
Fuse 
Gates 
Grid 
Ground 
Half-adder 
Help command 
 
Help menu 
Help, using 
IC 
Importing EWB circuits 
Inductor 
Instruments, list of 
Instruments, using 
JFETs 
JK flip-flop 
Keyboard shortcuts 
LED 
Label command 
Logic analyzer 
Logic converter 
MOSFETs 
Menus 
Models command 
Monostable multivibrator 
Mouse, using 
Mouse buttons 
Multimeter 
Multiplexer 
Multiplier 
N-channel JFET 
NAND gate 
New command 
NOR gate 
NOT gate 
NPN BJT 
Opamp 
Open command 
Opening a PC circuit on a Mac 
Opening a Mac circuit on a PC 
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OR gate 
Oscilloscope 
Output table 
Parts bin 
Paste command 
Pause after each screen 
Pause command 
P-channel JFET 
PNP BJT 
Potentiometer 
Preferences command 
Print Setup 
Print command 
Probe 
Pull-up resistor 
Quit command 
Relay 
Resume command 
Revert to Saved command 
Resistor 
Rotate command 
RS flip-flop 
Sample circuits 
Save As command 
Save command 
Selecting and choosing 
Serial number 
Seven-segment display 
Sharing circuits 
Shift register 
Shockley diode 
Show Clipboard command 
Showing the grid 
Showing labels 
Showing values 
Showing models 
Silicon-controlled rectifier 
 
Simulation 
Steady-state analysis 
Stopping a simulation 
Subcircuits 
Switch, manual 
Switches, general 
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Text, adding 
Time-delay switch 
Tips 
Tolerance, of solution 
Transformer 
Transient analysis 
Transistors (BJTs) 
Triac 
Tristate buffer 
Truth table 
Undo (Revert to Saved command) 
User support 
Values, specifying 
Variable capacitor 
Variable inductor 
Variable resistor 
Voltage sources 
Voltage-controlled current source 
Voltage-controlled switch 
Voltage-controlled voltage source 
Voltmeter 
Window menu 
Windows, using 
 
Wire Color command 
Wiring a circuit 
Word generator 
Workspace 
XOR gate 
XNOR gate 
Zener diode 
Zoom command 
 
 
Перевод «Оглавление справки»: 
Выберите тему (раздел) для информации 
Использование мыши и клавиатуры 
Части инструментальных средств 
Формирование и тестирование схемы 
Компоненты 
Приборы 
Ссылки меню 
Поддержка пользователя 
Индекс 
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    Чтобы закрыть это окно, дважды щёлкните системное меню в верхнем 
левом углу. 
    В дальнейшем, если желательно видеть окно справки во время работы, то 
включите поверх остальных окон в окне справки справочное меню, выбрав 
«Параметры», «Размещение окна», «Поверх остальных окон». 
 

3. Сумматор по модулю q 
 

Широкое применение в теории и практике проектирования цифровых 
устройств находят поля Галуа, в которых используеются операции сложения и 
умножения целых чисел по модулю q, где q – простое число. Такие поля 
содержат q элементов: 0; 1; 2; …; q-1. Число W по модулю q равно остатку от 
деления данного числа на q. 
На вход сумматора по модулю q могут поступать числа 0 ≤Х≤ q-1 и 0 ≤ Y ≤ q-

1. Сумматор должен вычислять сумму Z=(X+Y)q, где число Z равно остатку от 
деления суммы Х+У на число q. Понятно, что для чисел q, X, Y Z необходимо 
использовать двоичное представление, т. е. эти числа следует представить в 
виде: q=(qn,, ..., qp,, ..., q1);  Х=(xn, ...,xp, …, x1); У=(yn,,...,yp,...,y1), Z=(zn, ...zp, ..., 
z1), где qp, xp, yp и zp—двоичные разряды соответствующих чисел. Требуется 
синтезировать сумматор по модулю q при любом значении n. 
Традиционные методы синтеза (таблицы истинности, диаграммы Вейча) не 
могут быть использованы для логического проектирования сумматоров по 
модулю q, так как по условию задачи число двоичных разрядов не задано. В 
данном случае следует воспользоваться арифметическими свойствами входных 
и выходных переменных, а в качестве основных элементов - двоичными 4-раз-
рядными сумматорами. 
Рассмотрим двоичную сумму 

S=(X+Y)+(2n-q),                                          (1) 
где S=(Sn+1, Sn, .., Sp, ... S1), а вес двоичного разряда Sn+1 равен 2n (отметим, что 
сумма весов всех остальных разрядов равна 2n-1). Очевидно, что сумма S 
может принимать значения: S<2n и S ≥ 2n в зависимости от значений чисел Х и  

Y  (однако, следует иметь в виду, что при любых значениях чисел Х и У сумма 
S<2n+1). 

Если сумма S<2n, то Sn+1=0 и из соотношения (1) следует, что X+Y< q а 
значит, Z=X+Y=S-2n+q=<S+q>, где символ <А> означает исключение у 
величины A=(аn+1, an, …, a1)  разряда  an+1, т. е. <А > = (an, …, a1). 

Если же сумма S ≥ 2n, то Sn+1=1 и из соотношения (1) следует, что Х+У≥ q, 
а значит, Z=X+У- q =S-2n=<S>, Таким образом, имеет место соотношение 
                                                           <S+q>, если sn+1=0 

Z=(X+Y)q=          <S>, если sn+1=1.                                              (2) 

На основании соотношения (2) может быть построена схема сумматора 
по модулю q, где q — любое простое  число. На рис. 1 показана схема 
сумматора для случаев, когда число q можно представить не более чем 
четырьмя разрядами (q=3, 5, 7, 11, 13). Двоичный сумматор D1 производит 
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вычисление суммы чисел Х= (x4, …, x1) и Y=(y4, …, y1), двоичный сумматор D2 
вычисляет сумму S, определяемую соотношением (1), поскольку 2n-q=( 

1n q...,q )+(0, 0, …, 1) -  дополнение числа q до числа 2n. Разряд sn+1=S5 суммы (1) 
формируется с помощью ЛЭ ИЛИ. Если S5=0, то ЛЭ ИЛИ—НЕ выдают число 
q=(q4, …, q1), поступающее на входы двоичного сумматора D3, который и 
вычисляет сумму Z=(X+Y)q. Если же S5=1, то ЛЭ ИЛИ—НЕ выдают число 
0=(0, 0,0, 0). Таким же способом могут быть построены сумматоры по модулю 
q для любого q=(qn, …, q1), где n>4. 

Рис. 1 

 
Если q=2n-1 (при n=2, 3, 5, 7, 13, 17, 19, 31 числа q — простые), то схема 
сумматора по модулю q упрощается, так как 2n-q=1 и сумма (1) вычисляется с 
помощью одного двоичного сумматора (число 1 подается на вход сумматора 
D1, а сумматор D2 и ЛЭ ИЛИ исключаются). При (q=const схема сумматора по 
модулю q может быть упрощена за счет исключения ЛЭ ИЛИ— НЕ. В этом 
случае следует получить сигнал 1ns +  и подать его на входы двоичного 
сумматора D3, соответствующие числу q. На рис. 2 показана схема сумматора 
по модулю 7 (7=23—1), выполненная на основе 4-разрядных двоичных 
сумматоров (здесь достаточно было бы использовать 3-разрядные двоичные 
сумматоры). 
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                                                            Рис. 2 

 
 

4. Подготовка к выполнению работы 
 

4.1. По рекомендуемой литературе [1-3] уточнить работу многоразрядных 
двоичных сумматоров. 
4.2. По [3] уточнить понятия прямого, обратного и дополнительного кодов. 
4.3. Изучить контрольные вопросы. 
4.4. Сделать заготовку отчета по лабораторной работе (см. п. 7) 
 

5. Лабораторное задание 
 

5.1. Получить у преподавателя значение модуля q для построения сумматора 
(X+Y)q. 
5.2. Синтезировать схему сумматора по модулю q. 
5.3. Проверить правильность работы сумматора (X+Y)q с помощью пакета 
Electronics Workbench, подав на вход сначала X+Y<(q-1), а затем X+Y>(q-1). 
5.4. Нарисовать реализацию сумматора по заданному модулю q на АЛУ 
КР1533ИП3 ( в режиме суммирования). 

 
 

6. Контрольные вопросы 
 

6.1. Как представить целое число в прямом, обратном и дополнительном 
коде? 
6.2. Как выглядит схема трехразрядного двоичного сумматора с 
последовательным переносом на базе полных одноразрядных сумматоров? 
6.3. В каком диапазоне находятся значения суммируемых чисел X и Y , 
подаваемых на сумматор по модулю q? 
6.4. Чему равен результат суммирования  в сумматоре (X+Y)q? 
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7. Содержание отчета 

 
В отчете привести: цель лабораторной работы, выражения (1) и (2), рис.1, 
рис.2, функциональную схему разработанного сумматора по заданному 
преподавателем модулю q, результат проверки правильности 
функционирования разработанного сумматора с помощью пакета Electronics 
Workbench. 
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